
   

FrogPond Tutorial

    
What causes variation
among individuals?
This tutorial will challenge you to design and conduct experiments to 
determine the cause(s) of variation in a model population. The popula-
tion you will study is ficticious, but the tutorial is loosely based on a true 
story. In recent years, in a variety of places in North America, school 
children, biologists, and ordinary people have discovered populations 
of frogs with high frequencies of startling deformities, including extra 
legs. The suspected causes of deformity, some incriminated by stron-
ger evidence than others, include UV radiation, water pollution, and a 
parasitic trematode worm, called Ribeiroia, whose larvae can encyst in 
the tissues of tadpoles and disrupt their development.
Software for Evolutionary Analysis © 2002 Jon C. Herron 1



 

2

 

 What causes variation among individuals?

   
Your challenge will be to investigate the cause, or causes, of defor-
mity in a frog population that is split between two ponds. More specifi-
cally, you will first determine if there is a difference in the frequency of 
deformities in the two ponds. If there is a difference, you will then con-
duct experiments to figure out why.

If there is a difference in the frequency of deformity in the two 
ponds, it could be due to parasitic worms, genetics, a combination of 
worms and genetics, or random chance. I know, because I wrote these 
causes into the different scenarios available in the computer simulation 
you will use.

The FrogPond application
To complete this tutorial, you will need the software application 

FrogPond. You can download FrogPond from Jon Herron’s website at 
the following URL:

 http://faculty.washington.edu/~herronjc/

Click on Software, then on FrogPond. There are versions of FrogPond 
for Windows, Mac OS Classic, and Mac OS X. Download the appropri-
ate version to your computer and launch it.

The first window you will see is an ad for my book. Click on the Pro-
ceed button to dismiss it.

Next you’ll see a small dialog box asking you to select a scenario 
from a popup window. Don’t worry about what this means. Just pick 
scenario one, two, or three. (We’ll save scenario 4 for later). Then click 



 

The FrogPond application          

 

3

 

the Okay button. Don’t be alarmed if it takes a while for the dialog box 
to go away. Please be patient; the computer is setting up a simulation 
for you.

Now you will see FrogPond’s main window (see next page). On the 
left are two large ponds, Top Pond and Bottom Pond. They are full of 
frogs, represented by the green dots. Click on some of the frogs, and 
hold the mouse button down, to get a better look at them (right). The 
smaller dots are tadpoles (below, left). The larger ones are either normal 
frogs (below, center) or deformed frogs with extra legs (below, right).

Click the Run button on the lower right. You’ll see the frogs move 
around, mate and make tadpoles (watch closely!), and die. Tadpoles 
take 50 days to turn into frogs. Frogs live another 150 days after matur-
ing. Click on the Pause button to suspend the simulation.

The red dots in the ponds represent parastic worms. Notice that 
when you click on a tadpole or frog to look at it, the box that pops up 
sometimes has a red dot in the lower right corner. This indicates that 
the tadpole or frog is infected with the parasite. Infections can only be 

Not infected with worms Infected with worms
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The two large
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and Bottom P
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The four small white boxes are 
experimental ponds where you can 
conduct your research. To move a frog 
or worm to an experimental pond, click 
on the it, hold the mouse button down, 
and drag it to its new location.  

You can type labels 
here to keep track of 
your experiments.

This button will empty 
the pond of frogs and 
worms. You can get rid of 
a particular frog or worm 
by simply dragging it out 
of the pond.

This button will run the 
simulation. Click on it to see 
the frogs swim around and 
mate with each other.
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initiated in tadpoles. A tapole becomes infected when it bumps into a 
parasite. Once a tadpole becomes infected, it remains infected for life—
even after it turns into a frog.

Note that you can move frogs and worms around, by pointing at 
them, holding the mouse button down, and dragging them to a new 
pond. This gives you the ability to design and conduct your own experi-
ments. The quesions you need to answer are covered in the following 
two sections. Note: For each scenario, you must answer Question 1 
first. If you skip straight to Question Two, you may waste a lot of time.

Question 1
Is there a higher (or lower) frequency of deformed frogs in Top 
Pond than in Bottom Pond? How confident are you that your 
answer is correct?

The frequency of deformed frogs is their proportional representation 
in the pond. If, for example, six out of ten frogs are deformed, then the 
frequency of deformed frogs is 6 / 10 = 0.6, or 0.6.

To answer Question 1, you need to survey the frogs in Top Pond and 
the frogs in Bottom Pond. It’s a good idea to count each frog only once 
(why?), and to record your data as you go.

Here is a suggestion for a simple way to do your survey. Start with 
Top Pond. Pick a frog at random, and check to see if it is deformed. If it 
is, drag it to the upper left experimental pond. If it is normal, drag it to 
the upper right experimental pond. Note that each experimental pond 
has a counter next to its lower right corner that keeps track of the num-
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ber of frogs in the pond. Note also that you can type a label above the 
experimental pond to remind you of what you are putting there. After 
you have sorted a bunch of frogs into the deformed vs. normal experi-
mental ponds, take the number of deformed frogs and divide it by the 
total number of deformed + normal frogs. That will give you the fre-
quency of deformed frogs in your survey. 

Sorting the entire population in top pond would be pretty tedious, 
so you will probably want to stop early. How many frogs do you think 
you need to survey to get a fairly accurate estimate of the true fre-
quency of deformities in Top Pond?

After you have an estimate you are comfortable with for top pond, 
survey Bottom Pond. Then compare the frequencies for the two ponds. 
Depending on whether you are doing Scenario 1, 2, or 3, it is possible 
that there is really no difference in the frequency of deformity in Top ver-
sus Bottom Pond, and that any apparent difference is just due to ran-
dom chace. That is, it was just the luck-of-the-draw in the frogs you 
happened to survey that is making it look like there are more deformed 
frogs in one pond or the other. Do you think this is the case? Or do you 
think there really is a difference between the frequency of deformity in 
Top versus Bottom Pond?

When you are finished with your survey, you can return the frogs 
from the experimental ponds to Top and Bottom ponds. An efficient 
way to do this is by clicking the clear button under each experimental 
pond. This will present a dialog box letting you tell the computer what to 
do with the frogs.

If you think any apparent difference in the rate of deformity is just 
due to chance, skip the section on Question 2 and read on. If you think 



 

Qustion 2          

 

7

          
there really is a substantial difference between Top versus Bottom 
Pond, proceed to Question 2.

Question 2
If there is a difference in the frequency of deformed frogs in Top 
Pond versus Bottom Pond, then what is its cause?

Possible answers are: 
1. The frogs in one pond are, on average, genetically more prone to 

deformity than the frogs in the other pond (the worms are irrelevant); 
or

2. The deformities are caused by the worms, and one pond has more 
worms than the other (genetics is irrelevant).

Your challenge now is to design and conduct experiments that will 
allow you to determine which answer is correct. Here are some things 
you might do in the course of your experiments:

• Examine the frogs, and classify and count them.
• Record your data in tables or graphs.
• Move frogs (and, if you like, worms) from the big ponds to the smaller 

experimental pools. Run the simulation for a while (an entire genera-
tion takes 200 days), then examine the frogs in the pool. Note that 
you can type labels into the rectangles above the pools to keep track 
of what you’ve put there.
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• Mate particular frogs with each other. Move two frogs to a pool. 
Encourage them to mate by making sure they are touching each 
other. Run the simulation for a short time. You will see the parents 
produce one or two tadpoles. Let the tadpoles grow up, then exam-
ine them.

• Get rid of frogs or worms by dragging them out of a pool or pond, or 
by using the clear button.

• If you need to reset your simulation, you can do so with the Reset 
command under the File menu. (Note, however, that if you do this 
you will have to repeat your surveys of Top Pond and Bottom Pond. 
In different runs of the same scenario, the pond with the higher rate 
of deformities may change.

You will have noticed that I have only told you pieces of what you 
might do during your experiments. I haven’t told exactly what experi-
ments to set up. That is up to you. I will, however, offer three pieces of 
general advice. First, an effective way to proceed is to pick one of the 
two possible answers as your working hypothesis. It doesn’t matter 
which one. Then do something with the frogs. Predict what will happen 
if your hypothesis is right, and what will happen if it is wrong. Then col-
lect data to see what actually happened. Second, you may have to 
repeat an experiment several times before a clear pattern emerges in 
the data. Third, if your experiment does not produce a clear outcome, 
then try a different experiment.

When you are confident you know what is going on with the frogs in 
your ponds, proceed to the next section.



 

Learning the Truth          

 

9

    
Learning the Truth
Because FrogPond is a simulation, it allows you to do something you 
cannot do in the real world. You can ask the application to tell you the 
Truth about the simulation you are running. Under the Tools menu, 
select Tell the truth. Enter the password ‘Kermit’. Then click Now tell 
me.

Were you right? If not, try to figure out why your experiments failed 
to produce a clear answer, or why they led you astray. Try to design a 
new experiment that will give you the right answer. Then run your new 
experiment and see if it works.

Try another scenario
Under the File menu, select Reset. Pick a different scenario. Then 

repeat your investigations of Question 1 and Question 2. When you 
think you know what’s going on, ask FrogPond to tell you the Truth.

If you get tired of the laborious surveys that you have to do to 
answer Question 1, here is a shortcut. Under the Tools menu, select 
Sample. This will give you a small dialog box. Select the pond you want 
to survey, and the number of frogs you want to check. Then click Sam-
ple. FrogPond will do the survey for you and tell you the result.

FrogPond’s method of surveying is a little bit different than yours. It 
picks a frog at random, then throws it back in the pond. Then it picks 
another frog at random. This procedure has a serious flaw: It may count 
the same frog twice. But in the context of this simulation, it also offers 
an advantage. Even though there are only 100 frogs in the pond, you 
can ask FrogPond to sample 1000 frogs. Yes, this counts every frog 
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several times. But it also gives you a pretty accurate estimate of the true 
frequency. (If you don’t believe me, check for yourself.)

If, in the Sample dialog box, you ask FrogPond to sample both 
ponds, it will report the relative risk of deformity. This is the frequency of 
deformity in Top Pond divided by the frequency in Bottom Pond. If the 
relative risk is close to 1, then the frequency of deformity is about the 
same in both ponds. If the relative risk is a lot smaller than one, it means 
that the frequency of deformity is higher in Bottom Pond. If the relative 
risk is a lot bigger than one, it means that the frequency of deformity is a 
lot higher in Top Pond.

If you are still having fun, and if you feel confident in your ability to 
design experiments and interpret the results, try to figure out what’s 
going on in Scenario Four.
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